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Introduction and Week 1

Word Templates and Styles

INTRODUCTION
 Was a software developer for ten years and found she liked
doing the technical documentation and training better than
developing custom financial applications.
 Began being a “real” technical writer in 1987 for Microsoft. My
first project was the Windows System Developer’s Kit (SDK)
which is what developers used to create applications to run in
Windows.
 Received a certificate in Technical Writing and Editing from
University of WA and then was immensely more hirable.
 Went back to school and obtained a M.Ed. in Educational
Technology and started doing teaching as well as technical
writing.
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INTRODUCTION
 Developed documentation from end user to development audience levels
 Created web-based, online help, SharePoint, Wiki, API, e-learning, and other outputs
 Created documentation and/or training in pharma, lab management, health care,
software, donation management, cell technology, defense, recruitment
 Has certificates in Web Development and Design, Distance Education, Project
Management, and Business Process Improvement
 Also has certificates in Forensic Science and in Mystery and Suspense Writing (for fun)
 Certified trainer for Adobe RoboHelp and Captivate
 Am a contributing writer in Joe Welinske’s Developing Online Help for Windows 95 and
in HTML in Action, by Bruce Morris
 Wrote 4 books that are available on Amazon
 Currently the president of the local chapter of the Society for Technical Communication, a
professional development society for technical writers and editors
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AGENDA
 Contact Information
 Logistics
 Class schedule
 Breaks
 Office hours

 Projects
 Portfolio
 2-minute movie

 Plagiarism
 New signoff when submitting homework

 Expectations





Equipment
Textbooks and software
Attendance
Homework
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CONTACT INFORMATION
Instructor: Lin Laurie
Phone: 206.900.1861 Don’t use text messaging. Do not call after 8 pm.
E-mail: llaurie@uw.edu Alternate emergency: lin@linlaurie.com
Office Hours:
Before class starting at 5:30 pm, After class, Or by appointment (phone, online, or
in person)
Please conduct course correspondence through Canvas email.
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LOGISTICS: BREAK AND CLASS SCHEDULE
Class Hours
Wednesdays 6-9 pm (will try to leave last 15 minutes for questions)

Break(s)
7:20-7:30 pm*

Office Hours
5:30-6 pm on Wednesdays
Other office hours available on request by sending an email to me at
llaurie@uw.edu
*Approximate times and we will try with one break. We may have a second “energy”
break after we try it for a couple of weeks and see how you’re doing.
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EXPECTATIONS: EQUIPMENT
Equipment in a Virtual Class Environment
As technical communication in the workplace is largely done digitally and often remotely, you
should expect to have remote access capabilities to submit your in-class writing and homework
assignments. Homework should be submitted in a digital format. You should bring a laptop or
other device to each class.
You will need access to Wi-Fi through your NetID.
Your device should have web browsing capabilities.
The main tools and formats we will use are text files, Microsoft Word.docx and Adobe Creative
Suite. Microsoft Office 365 is freely available to students with your UW credentials. Creative
Suite is available on a monthly basis for a reduced fee with your UW Credentials.
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EXPECTATIONS: TEXTBOOKS AND SOFTWARE
Textbooks
We will not be requiring any textbooks for this course. All reading will either be in
documents provided, or links to web sites.
Software
We will be using the following software:
 Microsoft Outlook 365 Pro (which you should already be using and is available from
the UW software site)
 Adobe Creative Suite (available on the UW website for a reduced subscription rate)

The Adobe Creative Cloud Suite is available as an annual subscription. The license period runs
from July 14 through July 13 of the following year. Verify that you have to pay by reading the
site carefully. They say you have to pay for the year but I accidently had two versions and I
was able to cancel one without any problems because I installed in on two computers.
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EXPECTATIONS: TEXTBOOKS AND SOFTWARE CONT
 SnagIt from TechSmith (this is a very inexpensive screenshot utility that costs $49)
and will let you create professional screenshots, automate inserting them into Word,
and much more. Totally worth the money. They do have a short trial. While I can’t
likely teach in class, I can teach it in a free, 2-hour Saturday class if you purchase it
and you will be delighted to have gotten it.
 Grammarly Is a writing and editing tool that is highly recommended. You can get a
free version, but I recommend the Pro version, which you can get on a monthly basis
for $11 per month. If you don’t feel that it is helpful to your writing, you can cancel
after the 10-week class is complete if you sign up for the monthly version.
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EXPECTATIONS: TEXTBOOKS AND SOFTWARE CONT
 Envato is a repository of templates for PowerPoint, voice, WordPress, Music,
PowerPoint Presentations, and Sound, Fonts, and even stock photos. They also offer
courses and tutorials. The have a student price at $11.50 but to get it you must pay
for the year.
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EXPECTATIONS: ATTENDANCE
Need to update for April class!!!

©2016 LIN LAURIE, ALL RIGHTS RESERVED.

11

COURSE OBJECTIVES
After completing this course students should be able to:
 Create multiple, professionally designed documents suitable for multiple audiences and
for multiple outputs (video, print documentation, online help, web sites, and other
communication types)
 Use design elements such as color, typography, images, fonts, contrast, and more to
create effective communication pieces
 Conduct simple document or help usability testing to determine the efficacy of
deliverables
 Evaluate their own work and that of team members to make sure it measures up to best
practices
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TYPES OF TECHNICAL WRITING DELIVERABLES
 Contracts
Customer Service scripts
Demonstrations
Design documents
FAQs (Frequently Asked
Questions)
 How-to videos
 Instructions
 Knowledge base articles





 Online and embedded help
 Policy documents
 Process flows







Project documents
Product catalogs
Product packaging
Proposals
Release notes
Reference guides










Requirements specifications
Simulations
Training course materials
User manuals
Warning labels
Web-based Training
Websites
White papers

Note: This is not an exhaustive list.
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EXPECTATIONS: EPORTFOLIOS
What's an ePortfolio?
ePortfolios are a place where you can display and discuss the significant submissions and
experiences that are happening during your learning process. You can use an ePortfolio to:
 Display the papers you're proud of for more than just your instructor to see
 Talk about all the thought and work that went into your class submissions
 Gather an overview of your educational experience as a whole
 Share your work with friends, future employers, etc.
 ePortfolios can be public for everyone to see, or private so only those you allow can see, and
you can change that setting at any time.
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INTRODUCTION TO TECHNICAL WRITING (CONTD)
PROFILE OF A TECHNICAL WRITER
Here is the real profile of someone
responsible for documenting how things work
and how they should be used:
 You are someone who wants to save
people from frustration, anger, and upset.

You are an unsung hero to
your audience when you do
your job well!

 You like to help people find information.
 You enjoy writing in a way that helps
people understand complicated subjects.
 You like to empower others with
information.
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PORTFOLIO PROJECT
 The Portfolio Project is an extremely
important part of this course.
 The objective is for you to create a
form of technical communication that
you can show to others for the purposes
of gaining a job, grant, scholarship,
internship, etc.
Portfolio projects work best when they are
completed to a high level of writing,
design, and execution. They should
represent a topic and format that
matches your own personal and
professional interests.

 Portfolio Project milestones are due
online by the beginning of class on the
day they are due.
 You will receive a Complete or
Incomplete at some time following the
class period.
 Incomplete: An Incomplete will be
accompanied by feedback about
converting it to a Complete.
 Complete: You have 48 hours from
receiving an Incomplete to submit the
necessary adjustments or the
Incomplete will stand.
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INTRODUCTION TO TECHNICAL WRITING (CONTD)
THE TECHNICAL WRITING LIFECYCLE

Technical writing follows a development lifecycle that often parallels an
organization’s product development lifecycle:


Scoping – Identification of needs, audience(s), and scope



Planning – Defining deliverables and resources



Content – Includes research and content development



Testing – Includes use cases (if appropriate), review, and revision



Implementation – Includes delivery, rollouts, and production



Evaluation – Includes feedback, post mortem, or document review



Disposition – Includes future plans for the document (revision,
archiving, or destruction)

Scoping

Disposition

Planning

Technical Writing
Lifecycle
Evaluation

Content

Implementation

Testing
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INTRODUCTION TO TECHNICAL WRITING (CONTD)
TAKING A PERSONAL WRITING INVENTORY
 How do you feel about writing?
 How does it feel when you receive criticism of your
writing?
 Can you separate yourself (your ego) from your work?
 Do you like revising and rewriting something you’ve
already worked on?

Use the Taking a
Writing Inventory
handout to evaluate
your internal writing
mindset!

 Can you let your work go before you feel it is perfect?
Let’s take out our Taking a Writing Inventory handout and spend the next 10 minutes evaluating
how we feel about the writing process to see if this is really a field you’ll enjoy working in.
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INTRODUCTION TO TECHNICAL WRITING (CONTD)
TAKING AN INVENTORY OF YOUR OTHER TRAITS

Circle the following qualities to describe the type of person you are:








Thoughtful
Likes to Research Information
Quiet
Introspective
Detail Oriented
Organized
Determined to get answers








Outspoken
Inquisitive
Investigative
Great Technical Knowledge
Great Communication Skills
Innate Curiosity
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INTRODUCTION TO TECHNICAL WRITING (CONTD)
CLEARING UP ASSUMPTIONS

If you think that technical writing can:
 Provide you with a creative outlet, it won’t and shouldn’t. It’s purpose is to convey the
information your audience needs in as few words as possible so they may quickly perform
an action. The creative challenge that is available to you within those confines is to figure
out how to convey information quickly and provide the fastest access to it.
 Become an ego builder to turn you into an expert, it usually won’t but some people have
been able to turn their technical knowledge into a second career as a trainer, consultant,
etc. It takes a long time to get there and the path requires a lot of free writing to
establish yourself.
 Lead you into another career as a trainer, it might if you really want it, but the education
required to become a technical writer is much less than that to become a trainer, teacher,
or instructional designer. You usually need a master’s degree in Education or Ed Tech to
really do well in this field because that’s what your competition brings to the table.
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YOUR ROLE AS A TECHNICAL WRITER
Section Objectives:
At the end of this section you should be able to:
 List ways of using aspects for critical thinking to facilitate your writing process
 Talk about how you can establish common ground with an intended reader.
 List the four types of audiences you will be writing for.
 Describe how to analyze your audiences needs.
 Discuss ways to engage subject matter experts in the technical writing process.
 Discuss your ethical and legal obligations as a technical writer.
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YOUR ROLE AS A TECHNICAL WRITER (CONTD)
REQUIRED SKILLS

Really good technical writers use a variety of  Analyzing needs of an audience that you
methods to work with a diverse group of
may never directly interact with can be
people and pull information from those
challenging but is a very much needed skill to
people on topics they may know nothing
have.
about. Those skills and techniques include:
 Subject Matter Experts - Establishing
 Critical thinking – You’ll learn what it is
relationships with people who know a lot more
and how to use those skills to generate
than you do about a technical subject. Those
ideas for your writing.
are your Subject Matter Experts (SMEs).
 Establishing common ground with an
 Researching using a variety of tools such as
unknown audience. There are steps you
Google, developing other resources in a
can take to do this while never speaking
company, and finding documentation that
to that defined audience.
might help you. I call this the Snooping skill.
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YOUR ROLE AS A TECHNICAL WRITER (CONTD)
USING CRITICAL THINKING

What is critical thinking when applied to technical writing?
Critical thinking is a process that involves 6 steps from learning new information to being
able to synthesize it into your own writing with clear comprehension.
The six steps involve:
1. Knowledge

4. Application

2. Comprehension

5. Synthesis

3. Analysis

6. Evaluation

©2016 LIN LAURIE, ALL RIGHTS RESERVED.

23

YOUR ROLE AS A TECHNICAL WRITER (CONTD)
THE SIX STEPS OF CRITICAL THINKING
The six steps of critical thinking are:
1. Knowledge – Acquire knowledge to identify what is being discussed: the topic, the
issue, the thesis, and the main points.
2. Comprehension - Understanding the material that you read, hear or see. In
comprehending, you make the new knowledge that you have acquired your own by
relating it to what you already know.
The more involved you are with the information, the better you will comprehend it. The
primary test of whether you have comprehended something is whether you can put
what you have read or heard into your own words.
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YOUR ROLE AS A TECHNICAL WRITER (CONTD)
THE SIX STEPS OF CRITICAL THINKING

3. Application - Application requires that you know what you have read, heard, or
seen, that you comprehend it, and that you carry out some task to apply what you
comprehend to an actual situation.
4. Analysis - Analysis involves breaking what you read or hear into its component
parts, in order to make clear how the ideas are ordered, related, or connected to
other ideas. Analysis deals with both form and content.
5. Synthesis - Synthesis involves the ability to put together the parts you analyzed with
other information to create something original.
6. Evaluation - Evaluation occurs once you have understood and analyzed what is said
or written and the reasons offered to support it.
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YOUR ROLE AS A TECHNICAL WRITER (CONTD)
CRITICAL THINKING PROCESS

1. Define the problem – We need documentation
to support operating the xyz product.
 Start with what you know.
 List what you know that you don’t know or
what is missing.
 Identify your Subject Matter Experts (SMEs)
 Gather information (ask SMEs, research, ask
co-workers, develop specifications).
 Start to write what you do know. Create an
outline, start to fill in the skeletal structure
with information even if it isn’t fully baked.

2. Keep asking more questions:
 What other documentation do we
need?
 Who will use the xyz? What do
we know about them? Age?
Reading level?
 When do we need it by?
 Will the product be ready by the
document due date?
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YOUR ROLE AS A TECHNICAL WRITER (CONTD)
CRITICAL THINKING PROCESS
3.

What else should I know or be asking that I
am not asking?



4.

How does this impact other tools/products?

Resource Questions

5.

Is there any existing documentation I can use
as a starting point for my document either
structurally or as a stylesheet?



What kind of graphics will I need?



Do I have anyone to help me with graphic needs?



Do I have editing resources?



Who are my other SME sources?

6.

Are there any operating or other
requirements I need to know about in order
to use the xyz tool?

Is there any negative impacts to using the tool/product?
Will I need to warn the user about the tool?

Do not be embarrassed to tell someone you don’t know or understand. It is better to identify your lack of
information up front than to write bad documentation. However, the best place to do that is offline from a
meeting so you don’t take up the time of multiple people to address your needs.
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YOUR ROLE AS A TECHNICAL WRITER (CONTD)
CRITICAL THINKING PROCESS

 Does my document need a table of contents or an index? Make sure
to include time to generate these items.
 Do I have assumptions about my document, my responsibilities, my
due dates, who is going to give me the information I need, the skills
and tools I need, or any other part of my role in creating this
document?

Don’t wait until
you have all
the answers to
start writing.

 Is there anything left that I don’t understand about what I need to
deliver?
 If you need more information at this point, request a meeting to
gather a group of SMEs and other support personnel together and
get the answers you need. Use this as a last resort.
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YOUR ROLE AS A TECHNICAL WRITER (CONTD)
ESTABLISHING COMMON GROUND
Definition of common ground:
In rhetoric and communication, common
ground is a basis of mutual interest or
agreement that's found or established in the
course of an argument.
Uses: This skill is useful when you are writing
analytical material, in instances when you
are trying to bring about common
agreement. It could be used in proposal,
policy, white paper, or abstract document
writing.

Methods to find common ground:
 Identify with your audience – Step into their
shoes and find out as much about them as you can.
 Identify false assumptions - Sometimes your
audience member’s interests or concerns are at
odds because of misconceptions or inaccurate
information. When you are speaking to
stakeholders, you may uncover some of these false
assumptions. Listen carefully to what people are
saying and not saying. If you can clear up
misconceptions, it can help audience members to
see how their various interests align.
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YOUR ROLE AS A TECHNICAL WRITER (CONTD)
ESTABLISHING COMMON GROUND
Methods to Find Common Ground
(CONTD):
 Connect with readers/users - Once you
know what your audience members have
in common, you can craft your message
in a way that makes each reader feel
that you “get” them.
 Use stories or metaphors that everyone
can relate to. Write in a conversational
tone and a common language that all
can understand.

For instance, a business leader talking about an
upcoming product launch with a marketing group would
not use “legalize” in his presentation.
When you connect with all readers, you have done
your job and brought then to a point of shared
understanding. They “get” it because you have found
the common ground!
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YOUR ROLE AS A TECHNICAL WRITER (CONTD)
AUDIENCE TYPES

When you start to analyze an audience, try to
identify them by type. These tend to fall into
four categories:
 Executives who make decisions regarding
product development and its role in the
company’s overall success may have little
technical knowledge but a firm grasp of how
to position the product as a business asset.
 Hardware or Software developers, who are
less concerned with sales and marketing
activities, need to know other details, such as
the specs and installation instructions.

 Experts will have in-depth technical knowledge.
They are most likely to have designed and
developed the product in question. They’ll be
interested in emerging trends and new
technologies. How does it compare against the
competition?
 Users will have the least technical knowledge.
They simply want the product to work and ‘do
something’ for them. They have little interest in its
business goals, marketing promises, or technical
architecture. Does it help solve their problems?
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YOUR ROLE AS A TECHNICAL WRITER (CONTD)
ANALYZING AUDIENCE NEEDS

How do you know what your audience needs if
you never met them?
 Develop a profile based on what you do know.
Age, reading level, perquisite knowledge of
software or hardware.
 Marketing is a good resource. They will know
who their target customer is and can give you a
good idea of your target audience.

 What are my deliverables and do they
meet my audiences needs? You may find
that you need to document changes instead
of creating an entire new user guide once
you look at this question closely.
 What is my user’s most pressing need?
That will also help you determine what
documents are needed to meet that need
and help you prioritize your deliverables.

 Define their needs - What does your audience
need to know and why?
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YOUR ROLE AS A TECHNICAL WRITER (CONTD)
ANALYZING AUDIENCE NEEDS
Other Considerations
In addition to the types discussed above, you also need to factor in their:


Delivery – How will the document will be delivered
(print, online, projection, PDA). Will it be read in the
office, on the road, or in more stressful situations, for
example, disaster recovery documents may be read in
very hazardous conditions? Are there security issues
around access and delivery?



Needs – Why does the reader need this document
and what do they hope to accomplish with it?



Preferred document type – for example, do they
have a preference or a need for printed or online
material.



Experience – The reader’s knowledge of the
application to date. Can we get away with
delivering something simple?



Training – likelihood that the user has had
some (or no) training with the application. This
may determine whether you need a Getting
Started Guide and/or the Introduction
chapters.



Access - When and where the document will
be accessed (work, home, travel).
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YOUR ROLE AS A TECHNICAL WRITER (CONTD)
ANALYZING AUDIENCE NEEDS
Other factors to include:


Age



Culture



Language



Level of education



Needs and interests



Skills

All of those factors will contribute to how the
document is written and delivered.
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YOUR ROLE AS A TECHNICAL WRITER (CONTD)
ANALYZING AUDIENCE NEEDS
The Audience Acronym
The AUDIENCE acronym can help you remember the most important parts of defining an
audience:


Analysis – Who is the audience?



Understanding – What is the audience’s knowledge of the subject?



Demographics – What is their age, gender, education, background etc.?



Interest – Why are they reading your document?



Environment – Where will this document be sent/viewed?



Needs – What are the audience’s needs associated with your document topic?



Customization – What specific needs/interests should you the writer address
relating to the specific audience?



Expectations – What does the audience expect to learn from your document? The
audience should walk away having their initial questions answered and explained.
©2016 LIN LAURIE, ALL RIGHTS RESERVED.
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YOUR ROLE AS A TECHNICAL WRITER (CONTD)
SUBJECT MATTER EXPERTS (SMES)
What is a Subject Matter Expert (SME)?
A subject-matter expert (SME) with
knowledge in a particular area or body.
They are sometimes referred to as a
domain expert, but either way they are
a person who is an authority in a
particular area or topic.
Note: The term domain expert is
frequently used in expert systems
software development.

How Do We Use SMEs in Writing?
 In areas where you have little or no
knowledge, they may give you guidance as
to the organizational structure of your
documentation.
 They will also give you content that while it
should be checked for accuracy in terms of
language or order, will likely be the
ultimate source of truth for your content.
 They should also be used as reviewers on
your material.
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YOUR ROLE AS A TECHNICAL WRITER (CONTD)
SUBJECT MATTER EXPERTS (SMES)
How Do We Engage with SMEs?
 Do not waste their time – When you are ready to discuss content with them, come
prepared to listen, take notes, (recording them is recommended) and bring a list of
questions with you.
 For follow up questions – Prepare a list. When you submit the list, also give them
context for your questions. For instance, if you have a question about what they said, find
the recorded statement and quote it so they know what they said and how to clarify it.
 Call a meeting and have them focus on what you need – Sometimes it is easier to get
a meeting placed on someone’s schedule and then have them review/address questions
in a quiet, focused place instead of sending them review requests.
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YOUR ROLE AS A TECHNICAL WRITER (CONTD)
SUBJECT MATTER EXPERTS (SMES)
Questions to ask a SME to help you get
started:

 Could you walk me through the basic process
from beginning to end?

 What information, tools, access,
software, or knowledge should my
audience have before they begin?

 What if this part of the process didn’t work?
What should the user do and how would that
effect the entire process?

 What is the goal for using this process,
software, hardware, or change? What
is being accomplished?

 Where are there handoffs to other systems,
users, processes, tools, or other connections?

 Is this a new process or a change to an
older process? IF it is a change, what
changed and why?

 Is there a dashboard, reporting method, or
other way of determining the state of data,
the process, etc. as it moves through its path
from start to finish?
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YOUR ROLE AS A TECHNICAL WRITER (CONTD)
SUBJECT MATTER EXPERTS (SMES)
Commonalities in Most Software Projects
or Processes:
 Is there a prerequisite process before we
start?
 They all have a beginning, middle, and
end.
 They usually have a place for data to be
input (screen, web, a batch). Where did it
come from?
 They usually have some method of seeing
the status of data: reporting, dashboard,
screen or web page, etc.

 They usually have some method of
seeing the status of data:
reporting, dashboard, screen or
web page, etc.
 They usually have some type of
output: reports, data that flows to a
new application, a completed status.
 Reporting capabilities: usually to a
screen or printed report.
 What happens next? Does it feed
into something else?
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YOUR ROLE AS A TECHNICAL WRITER (CONTD)
SUBJECT MATTER EXPERTS (SMES)
Commonalities in Most Hardware
Projects or Processes:
 Is there a prerequisite process before
we start?
 What is needed for the hardware to
start the process? (Input) Materials,
staff, knowledge, access (keys or
codes), and anything else?
 They all have a start and stop button.

 They all have something that happens
after you start and before you stop.
What is that process and what is the
output?
 What comes out when the process is
completed? (Output)
 What happens next? Is this the input to
another process?
©2016 LIN LAURIE, ALL RIGHTS RESERVED.
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YOUR ROLE AS A TECHNICAL WRITER (CONTD)
SUBJECT MATTER EXPERTS (SMES)

If you are inexperienced and feel they don’t respect you – This happens to every new
writer. The SME feels like they have to explain too much and it takes too much of their
valuable time so they decide to ignore you. It is very important to try to keep this from
happening by using the following tactics:
1. Research!!! When you are first assigned a
topic, research it as best you can using the
web, other material, and other people (such as
a project manager) before you start discussing
your topic and questions with a SME.

3. Record meetings with your SME. This way you can relax
and listen to them without worrying about how well
you’re taking notes. And you will have an accurate
transcript of their explanations. This will save you time,
give you very accurate notes, and will cause the review
process to go faster. You will get a reputation for speed
2. Be prepared - Make a list of questions for your
and accuracy.
SME and then try to answer them first by
googling the answer or finding other sources of
Note: Use their webinar tool and record even if you are in the
knowledge.
same room. You just dial into the meeting center and press
record and also have your computer linked to the meeting.
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YOUR ROLE AS A TECHNICAL WRITER (CONTD)
SUBJECT MATTER EXPERTS (SMES)

 If you are inexperienced and feel they don’t respect you – (CONTD)
4. Make friends with your SME – Sometimes this
works. Invite them out for coffee and ask them
for ways that you can beef up your knowledge
so that you don’t depend on them for basic
subject matter knowledge—just for the details
that are specific for the project. Enroll them in
supporting you instead of seeing you as
someone who will cost them time.

6. Bribe them with brownies or another favorite treat.
This will sometimes work when you get to the level of
desperation.
7. Request what you need in an email and cc their
manager and yours. This is a very last resort and you
should discuss it with your manager before you do it.

5. Ask them to help identify other people you
can go to for basic knowledge – People are
usually happy to give you the name of
someone else to point you at.
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YOUR ROLE AS A TECHNICAL WRITER (CONTD)
KNOWING HOW TO RESEARCH

Having super research skills is more than knowing how to basic
search terms in Google. Here are some tips for becoming a
super research sleuth!
 Search on your company’s intranet site for earlier versions
of a product’s documentation or specs. Use your access to
find out anything you can about a product that might not
come directly from your higher ups (unless specifically told
not to do so).
 Find out the names of other people on the project and
befriend them. Find people who are willing to discuss parts
of the project that you don’t understand without involving
your SMEs. Do not let shyness stop you from asking questions
and getting to know the people who will help you on the
project with the basic information you need to do your job.

Note: You want to save your
SMEs for the technical
material you will really need
them for.
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YOUR ROLE AS A TECHNICAL WRITER (CONTD)
KNOWING HOW TO RESEARCH

 Become a Super Googler! Type in “How to search on
Google” and learn more than you thought you needed to
know about using Google for the answers you need.
 Google unknown terminology as you work on your project
and compile a glossary of terms. It is a good thing to
include in your final deliverables for others to use.
 Use Wikipedia for unknown terminology. It is a great
source.
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YOUR ROLE AS A TECHNICAL WRITER (CONTD)
KNOWING HOW TO RESEARCH

 Search for all unknown acronyms and don’t assume you
know what they mean. Companies and even business units
within a company can use the same acronym or
abbreviation but have different understandings about its
meaning.
 Develop a system. I copy and paste everything into my
document and then as I actually write content, clean out the
copied text, write my glossary term or use the pasted info
in the content. But that pasted content does not become
part of the final deliverable. It just acts as dump site for the
information I’ve collected.
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YOUR ROLE AS A TECHNICAL WRITER (CONTD)
KNOWING YOUR ETHICAL AND LEGAL OBLIGATIONS
Writers have ethical and legal obligations when
writing technical material.
 Physical Devices - We are obligated to clearly
describe how to use physical devices, and point out
areas where there could be data loss or physical
harm.
 Software – We are obligated to warn users when
there is the possibility of data loss or corruption.

Take out the handout
Knowing Your Ethical
Obligations.doc
and discuss other areas
of legal or ethical
responsibilities.

In addition, we’ve got other legal and ethical
responsibilities that are related to the company we
work for and general responsibilities for how we
use, quote, refer to other people’s works.
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PRINCIPLES OF EFFECTIVE TECHNICAL WRITING
Section Objectives:
At the end of this section you should be able to:
 Describe methods for developing content.
 List ways to use knowledge of your audience in content development.
 Discuss which organizational patterns you will use to create a good document.
 Describe why you would use a style guide.
 List some of the rules regarding word usage in business and technical writing.
 Talk about the correct voice to use in technical writing.
 List the reasons why you would use a dictionary other than to correct spelling.
 Discuss how to keep unity and focus on your document’s content throughout the entire document.
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PRINCIPLES OF EFFECTIVE TECHNICAL WRITING (CONTD)
BEGINNING TO DEVELOP CONTENT
There are five basic questions a technical
writer has to ask themselves when starting a
new project – who, why, what, how and
when.
Answering these questions will allow the
technical writer to be able to develop the
content for any type of technical
documentation.
For example, let’s say the technical writer has
to create a user guide for a new video
recorder.

Before creating the user guide, they will have to
plan the content of the user guide by applying
following key questions to the situation:


Who will read the user guide?



Why do we need to create the user guide?



What is this user guide going to offer its
intended audience?



How is the user guide going to be delivered?



When does the user guide have to be ready
(publishing date)?
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PRINCIPLES OF EFFECTIVE TECHNICAL WRITING (CONTD)
AUDIENCE AND PURPOSE

Ask the following questions about your
audience:
 Who will read the document?
 What are their biases?
 What are technical writer’s ethical
responsibilities when communicating
this bias to the audience?

With regard to purpose, you should ask:
What should this document accomplish?
What should it do? Should it:
 Inform

 Report

 Request

 Reply

 Instruct

 Analyze or Critique

 Suggest

 Compare

 Order
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PRINCIPLES OF EFFECTIVE TECHNICAL WRITING (CONTD)
ORGANIZATIONAL PATTERNS

All writers use some kind of
organizational pattern to their
documentation to provide consistency to
their writing. Organizational patterns
provide the document with continuity and
structure so that audience can
comprehend the ideas being discussed.
For example, writers can organize their
ideas chronologically, spatially and
categorically.

Organization patterns for a document as a
whole include:


Table of Contents



Table of Figures



Document Body Divided into Sections or
Chapters



Index



Glossary of Terms



Appendix
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PRINCIPLES OF EFFECTIVE TECHNICAL WRITING (CONTD)
ORGANIZATIONAL PATTERNS

Quick Quiz!

Within the body of the document writers also
employ additional organizational patterns:
Here are a few examples for a user guide:


Organization of a chapter based on
priority of information:
 Introduction (contextual information
about the subject)
 Process information regarding what
happens before, what is about to
happen, and what the end results will
be.
 Numbered steps to instruct users on
how to perform a procedure.

Answers:


Additional processes in order of required
occurrence.



Notes or tips about process being discussed.



Branching information such as see also or
for more information, see page xxx.
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PRINCIPLES OF EFFECTIVE TECHNICAL WRITING (CONTD)
ORGANIZATIONAL PATTERNS
Within a procedure there are still
organization patters to know about:

Additional methods of applying structure
to content:

 The order of the steps in the procedure.

 Tables are a way to apply order to
the way information is displayed.

 The order of the procedures in a series.
 The simplicity of the sentence structure
used to keep the steps clear and
simple.
 Whether to include images or screen
shots and where they should appear
within a procedure.

 Bullets and numbered lists can be
used to help readers discern important
information and also whether the
information should occur in a certain
order (numbered lists) or is just
information that is needed (but without
a required order (bullets).
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PRINCIPLES OF EFFECTIVE TECHNICAL WRITING (CONTD)
STYLE GUIDES

A style guide contains rules on grammar usage,
punctuation, word or terminology usage, element
names for software interfaces, and more.
Use a style guide to:
 Provide a standard that all employees can
adapt.
 Create a more homogenous writing voice to
all documentation.
 Set standards for clarity and consistency that
will ensure that users receive information that is
easy to understand and process.

Note: Style guides can be published and
purchased for in-house used or developed
by a company’s technical writing team. Many
grammatical and punctuation rules are
subjective, as the ones described in the next
two slides.
Consistency is the
hobgoblin of little
minds… but not in
technical writing!
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PRINCIPLES OF EFFECTIVE TECHNICAL WRITING (CONTD)
STYLE GUIDES

Did you know?

 The 1 or 2 Space after a Period Rule:

The reason for using two spaces after a
period disappeared once we stopped
using typewriters. But even today,
technical writers will fight over this one,
mainly because they have leftover bad
habits.
Today, our software handles spacing
between each word and period so it is
no longer needed and can actually
cause problems with kerning if you use
more than one space after a period.

Source: The Microsoft Manual of Style for Technical Publications (Online version).
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PRINCIPLES OF EFFECTIVE TECHNICAL WRITING (CONTD)
STYLE GUIDES

 The Serial Comma Rule:

Did you know?
Many people learned NOT to use a
serial comma in their writing so using one
is against all their rules. They aren’t
wrong or right. It is a subjective rule and
that’s one more example of why we need
style guides.
If it matters to you that your writing have
the same look and feel, then make a rule
for this; otherwise, it isn’t a big deal to
users. Some will think you forgot it and
your writing is sloppy and some will
appreciate it depending on what they
were taught in school. You can’t really win
except in being consistent.

Source: The Microsoft Manual of Style for Technical Publications (Online version).
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PRINCIPLES OF EFFECTIVE TECHNICAL WRITING (CONTD)
WRITING STYLE AND WORD USAGE
Grade Levels and Word Usage - When you
know who your audience is, you know what
grade level you need to write to. For
instance, you wouldn’t use a word like egress
to mean exit when writing an instruction
telling readers with an 8th grade reading
level to leave a building. They won’t know
what you mean.
Multiple Meanings - Also there are words
that have multiple meanings and you will
want to have determined ahead of time
whether you want to use them, and what
meaning you want to have attached to them
for your documentation use.

Convulsion and Puffery - There are also
words you want to avoid because you think
they may appear to “puff” up the grade
level of your writing but they really do
nothing except make your document appear
more convoluted and more difficult for your
reader to understand.
Know the real meaning of the words you
use - Some words imply permission and
others imply capability: Can refers to
capability and may implies possibility or
permission. It is important to understand the
meaning of words when you become
responsible for communicating technical
direction to people.
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PRINCIPLES OF EFFECTIVE TECHNICAL WRITING (CONTD)
WORDS AND TERMS TO GENERALLY AVOID



Additionally – a weak transition. Use and, 
or find another way to transition to the next
part of your sentence.

Adjectives are relative to a reader’s
experience and have no place in technical 
writing.



Avoid contractions in technical writing.



Do not use “Do not” unless you are writing a
warning or danger item.



Basically, usually, or essentially. These
are filler words without any meaning.



Due to the fact – Use either because or due
to (depends on the sentence).

First or firstly – As soon as you start with this, you
know you need a numbered list.
Irregardless – It is not a word.
Jargon – try to avoid or make sure you define on
first occurrence in paper documentation or in every
topic in online help.



Often or frequently – people have different
opinions of what these mean. Use more specific
terms to describe time and avoid these words.



On account of – Use because instead.



Utilize – Instead substitute use.
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PRINCIPLES OF EFFECTIVE TECHNICAL WRITING (CONTD)
WORDS/TERMS TO GENERALLY AVOID


Use single words in place of
circumlocution:
Avoid circumlocution or use of more words in
a sentence than required to express the
purpose in business writing.



Avoid long sentences:
Avoid use of long sentences having many
clauses. Sometimes the reader loses the
beginning by the time he comes to the end of
the sentence.



Use technical words with care:
Every profession develops its own special
vocabulary or technical words. The members
of that professional group can easily
understand these technical words. But, if you
use these technical jargons in your business
communication to an outsider, it will sound
like a foreign language to him.



Avoid use of difficult words:
Use English words that are easy to use and
understand instead of difficult and highsounding words. Make your business writing
more effective with simple and direct word, and
avoid any possibility of misinterpretation of
your words by the reader.
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PRINCIPLES OF EFFECTIVE TECHNICAL WRITING (CONTD)
WORDS/TERMS TO GENERALLY AVOID


Use strong, powerful and direct words:
Use language that is direct and strong to
clearly indicate action and results.



Use active verbs:
Active verbs make your business writing
direct, clearer, more informative and easier
to understand. They also make it clear who
the actor is and what the action they should
take is.
Ex.: Take the cat outside. Vs. One should take
the cat outside.



Avoid use of camouflaged verbs:
Camouflaged verbs are verbs that are
unnecessarily changed to nouns. Avoid
camouflaged verbs and strengthen your
business writing.
Ex: Camouflaged: I have sent you a reply to
your letter.
Better: I have replied to your letter.



Use correct idioms and phrases:
Be careful in the choice of idioms and
phrases while writing business communication.
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PRINCIPLES OF EFFECTIVE TECHNICAL WRITING (CONTD)
ACTIVE VS. PASSIVE WRITING STYLE
In technical writing, the preferred style is
active voice.
This is especially true when writing
procedural documentation so that there is no
confusion between the action a user must
take vs. the resulting behavior of the device
or software.
The purpose of technical writing is to quickly
convey information about how to do
something.

Voice refers to the relationship between the
grammatical subject of a sentence and the
verb. In active voice, the person or thing
performing the action of the verb is the
grammatical subject. In passive voice, the
receiver of the action is the grammatical
subject.
In general, active voice should predominate.
Passive voice is not a grammatical error, but
it has the greatest impact when you use it
sparingly.

You may provide some contextual
information but the majority of it will likely
be procedural.
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PRINCIPLES OF EFFECTIVE TECHNICAL WRITING (CONTD)
ACTIVE VS. PASSIVE WRITING STYLE
Microsoft style (active voice)
You can divide your documents into as many
sections as you want.
Data hiding provides a number of benefits.
Windows XP includes many multimedia
features.
Not Microsoft style (unnecessary passive
voice)
Your document can be divided into as many
sections as you want.
A number of benefits are provided by data
hiding.
Many multimedia features are included in
Windows XP.

Voice refers to the relationship between the
grammatical subject of a sentence and the
verb. In active voice, the person or thing
performing the action of the verb is the
grammatical subject. In passive voice, the
receiver of the action is the grammatical
subject.
In general, active voice should predominate.
Passive voice is not a grammatical error, but
it has the greatest impact when you use it
sparingly.
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PRINCIPLES OF EFFECTIVE TECHNICAL WRITING (CONTD)

DICTIONARIES – HELP MAINTAIN A CONSISTENT WRITING STYLE
 Find an online dictionary that you like and bookmark it.
 Check with your tech writing team to see if they have a
recommended favorite.
 Always look things up instead of assuming a meaning. This is
especially important when dealing with diverse audiences, multicultural audiences, or others that may have different
understandings of words.
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PRINCIPLES OF EFFECTIVE TECHNICAL WRITING (CONTD)
DICTIONARIES – HELP MAINTAIN A CONSISTENT WRITING STYLE
Pick the most commonly used
definitions!
Usually the first or second definitions
are the most commonly accepted ones
so if neither of them are the ones you
want, then you need to look for
another word to use.
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PRINCIPLES OF EFFECTIVE TECHNICAL WRITING (CONTD)
ACTIVE VS. PASSIVE WRITING STYLE
Quick Assignment: Rewrite the
following three sentences to remove the
problem of passive voice:

Quick Quiz!

Answers:

1. Batches should be entered by 10
a.m.

1. Enter batches by 10 a.m.

2. The batch can then be given to the
coordinator.

2. Give each batch to the coordinator
as soon as you’ve entered it.

3. Ensure that all pays are entered in a
timely manner.

3. Make sure that all pays are entered
on time.
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PRINCIPLES OF EFFECTIVE TECHNICAL WRITING (CONTD)
FOCUS AND UNITY IN TECHNICAL WRITING
Unity Definition

Focus Definition

In composition, unity is the quality of
oneness in a paragraph or essay that
results when all the words and sentences
contribute to a single effect or main
idea. Also called wholeness.

Focus is the component of effective
technical writing that answers the
question “So What?” An effective piece
of writing establishes a single focus and
sustains that focus throughout the piece.

How can we keep the unity and focus of our
document clearly related throughout?
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PRINCIPLES OF EFFECTIVE TECHNICAL WRITING (CONTD)
FOCUS AND UNITY IN TECHNICAL WRITING

How can we keep the unity and focus of our document clearly related
throughout?
Overall:
1. Set a goal for your document.

For Each Section:
On a more granular basis do the same thing:

2. What is the reason for the document?

1. Set a goal for your document.

3. What problems is it solving?

2. What is the reason for the document?

4. Use organizational patterning to help
the reader understand the structure
of the document.

3. What problems is it solving?
4. Use organizational patterning to help the
reader understand the structure of the
document.
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DIFFERENT DOCUMENT DELIVERABLES
Section Objectives:
At the end of this section you should be able to:
 Describe how you would perform a content analysis during the development process.
 Describe the different parts of a memo.
 Define the different parts of a letter.
 List the various components that most reports have in common.
 Identify the components are needed to create a good user guide or similar manual.
 Define the common components of an abstract.
 Discuss the differences between writing a report vs. a proposal.
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DIFFERENT DOCUMENT DELIVERABLES (CONTD)
ANALYZING NEEDED CONTENT
Work Analysis Overview



A task analysis is an intensive
examination of how people perform
work activities. A task is a series of
actions or behaviors that accomplishes a
goal. Typically a task analysis deals with
observable steps.



A goal analysis is an objective means of
transforming vague desires into specific
targets for learner accomplishments and
is used to establish performance goals
which can then be used to develop
organization and content of your
documentation. This is the function of goal
analysis.

The process of gathering detailed information
about the work that people do is called work
analysis and encompasses four different kinds of
investigations:
 A job analysis is a comprehensive examination
of what people do, how they do it, and what
results they achieve. It is performed to clarify
work titles, activities, responsibilities, and entry
qualifications.
 A content analysis investigates the information
or knowledge requirements of work activities.
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DIFFERENT DOCUMENT DELIVERABLES (CONTD)
CONTENT ANALYSIS

Note: For the purposes of developing the content of a technical document, the
Content Analysis is the only one we need to focus on. The other three are used
more when developing training materials.
Used when doing strategic planning of your document’s contents or at the end of a document
process to review the entire content devoted to a subject matter in order to plan for the next
round of documentation (the end of the Document Planning Lifecycle).
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DIFFERENT DOCUMENT DELIVERABLES (CONTD)
PERFORMING A CONTENT ANALYSIS
A content analysis investigates the information or
knowledge requirements of your document(s).
It can include analyzing existing documentation to
find out what is missing or changed and then use that
information in the creation of a new set of document
requirements.
Content analysis is the process of breaking down
large bodies of subject matter or tasks into smaller
and instructionally useful units. These "instructionally
useful units" may include facts, concepts, processes,
procedures, or principles.

Content analysis is intended to:


Identify and isolate single idea or skill
units needed to be documented.



Act as an objective decision rule for
including or excluding topics.



Provide guidance to the order or
sequencing of topics.
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DIFFERENT DOCUMENT DELIVERABLES (CONTD)
CONTENT ANALYSIS FOR A SOFTWARE DOCUMENT
To perform Content Analysis:
1.

Create a table in Word or use an Outline
format.

2.

List the needs of the document. For
instance, the document is needed to help
users quickly begin using a new software
tool.

3.

Begin to break down the tasks the user
will need.

4.

Discuss with your team whether each task
is a quick start task or something covered
in a more comprehensive document. (The
weaning process.)

5. Review the interface and start determining
what screenshots would best help meet the
objectives of the document.
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DIFFERENT DOCUMENT DELIVERABLES (CONTD)
CONTENT ANALYSIS FOR A SOFTWARE DOCUMENT
6. Ask the following questions:
•
•
•

What order will best support the objective of the document?
Make changes to your list of tasks.
What other organizational or document structures would help
the user obtain information quickly? Do I need a table of
contents, index or other structures?
Is there any other information I should include in the document?
Review the contents and structure with your SMEs.

You now have the basic structure and preliminary contents
of your quick start guide and can start developing the
content according to the agreed upon content analysis.
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DIFFERENT DOCUMENT DELIVERABLES (CONTD)
MEMOS

Dos and Don’ts About Memos:

Did you know that you can
set your email program to
automatically spell check
when you press send?

Do:
 Keep the memo brief.
 Use bullets for important details. It also makes it
easier for people to quickly scan and get the
important points of the memo.
 Keep the writing style simple (almost to the point
of curt) no first or second personal pronouns.
 Do Not:
 Begin sentences with and, but, or due to.
 Exceed two pages (less is better).

Always remember to check spelling before you send!!!
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DIFFERENT DOCUMENT DELIVERABLES (CONTD)
LETTERS

Find out your company’s required style if you need to send out snail mail.
The will likely have requirements regarding the address, a footer, and
other possible components of the letter.
The following components are part of a letter:
 From – Does your company require this to be on the right or left side?
 To
 Date
 Salutation
 Body

Remember to check spelling
before you send!!!

 Closing
 Signature
 CC/ENC
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DIFFERENT DOCUMENT DELIVERABLES (CONTD)
REPORTS

There is a wide variety of reporting formats
and they all have their own set of requirements
but here’s an example of the type of
information required when writing a business
report. Your company will likely have its own
standard.
This is also an example of the kind of
information you could include in a Style Guide if
you develop your own in-house version.

 Cover
 Title Page
 Revision and Editing Dates and
Names
 Letter of Authorization
 Letter of Acceptance
 Letter of Transmittal
 Table of Contents
 List of Illustrations
 Executive Summary or Synopsis
 Body of Report
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DIFFERENT DOCUMENT DELIVERABLES (CONTD)
MANUALS

Most technical manuals, books, or user
guides have the same components in
common despite their topic content or
use:



List of Tables



Contents – Sections, Chapters, Contextual
Information, Procedures, and Other
Information



Tables and Figures



Glossary of Terms



Cover page



Revisions, Editing, and Publishing
Details page



Table of Contents



Index



Table of Illustrations or Figures



Appendices
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DIFFERENT DOCUMENT DELIVERABLES (CONTD)
ABSTRACTS

An abstract is a self-contained, short, and
powerful statement that describes a larger
work.
Components vary according to discipline.
 An abstract of a social science or scientific
work may contain the scope, purpose,
results, and contents of the work.
 An abstract of a humanities work may
contain the thesis, background, and
conclusion of the larger work.
 An abstract is not a review, nor does it
evaluate the work being abstracted. While
it contains key words found in the larger
work, the abstract is an original document
rather than an excerpted passage.

All abstracts share some of the same components:


Reason for writing - Why is this research
important?



Problem - What problem does this work attempt to
solve? What is the main argument?



Methodology - An abstract of a scientific work
may include specific models or approaches used.
Other abstracts may describe the types of
evidence used in the research.



Results – A discussion of any findings or results.



Implications – Recommended changes as a result
of the review of the problem.
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DIFFERENT DOCUMENT DELIVERABLES (CONTD)
GRANTS AND PROPOSALS

Usually a proposal is generated in order for
your company to obtain new business.
A proposal should include the following
elements:
Executive summary: State the reasons for
writing the proposal and summarize.
Statement of need : Detail why the project is
necessary.
Project description: Explain specifics of the
project and how they will be performed and
evaluated.
Budget analysis: Explain how the project will
be financed and categorize operating
expenses.

Things You Should Know About Writing Proposals:
If the proposal is being written to respond to a
general request for proposal (RFP), the requestor
could have a pre-defined format they require you to
use so that all proposals contain the same information
and make them easier to evaluate.
Some people develop careers solely to focus on this
type of writing because it is so specific and rigorous
and so important to growing companies.
The major difference between a grant and a proposal is that
a grant is to request funding to provide a service or for
research whereas a proposal is to perform specific work for
payment and for the benefit of the company that requests
the proposal.
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DIFFERENT DOCUMENT DELIVERABLES (CONTD)
OTHER COMMON TYPES OF DOCUMENTS
Functional Specifications – For new
software, these include rough drawings of
screenshots, fields, and data flow diagrams
or descriptions of data flow.
PowerPoint Presentations – You may be
asked to develop a slide presentation using
charts, graphs, bulleted points, and other
forms of communication.
Job Aids or Quick Reference Cards – These
are usually 1-page references that help
users quickly perform often repeated tasks.

Project Plans – While projects are unique,
the contents of a project plan are as well.
Ask for a sample of a similar plan or Google
samples to find one that fits your needs as a
starting point.
Online Help – Online help can be similar to
a document but everything is linked together
and you have the ability to search the entire
contents and other electronic features.
Visio Diagrams – These can include process
flow diagrams, data flow diagrams, network
diagrams, Gantt charts, etc.
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MECHANICS OF TECHNICAL WRITING
Section Objectives:
At the end of this section you should be able to:
 Use a template and styles to control the look of your document.
 Use built-in styles to auto-create a table of contents.
 Enable readability statistics in a document.
 Display the reading level for the document.
 Perform a spell check of a document.
 Turn on Track Changes.
 Submit a document for review.
 Work with a reviewers comments.
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MECHANICS OF TECHNICAL WRITING (CONTD)
USING TEMPLATES

Microsoft Word comes with a built-in
template called Normal.dot. It contains
the following components:
 Predefined styles for Headings, body,
and a few other styles shown in the
graphic.
 If you format your document using
these styles, you can change the font
or other components of a paragraph
style and change the look of your
document with a few clicks.

For instance, if you wanted your Normal body text to be 12
pt Arial and it is currently 10 pt Calibri, if you used Normal
as the style applied to all body text, you would just have to
make one change and it would change all instances of
Normal body text throughout your document.
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MECHANICS OF TECHNICAL WRITING (CONTD)
USING TEMPLATES

Other Reasons to Use Templates:
 Saves lots of formatting time when
creating documentation.
 Lets you apply a homogenous
corporate look and feel to all
documentation.
 Lets you use built-in heading styles to
auto-generate a table of contents.
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MECHANICS OF TECHNICAL WRITING (CONTD)
USING TEMPLATES

To Create a Customized Template for a
Document:
1. Open a new document.
2. Save the document as a template by
selecting File>Save As> and select
Browse.
3. Change the Save as Type to Word
Template *.dotx and the path will
change to the default path for
templates.

4. Open a new document.
5. Save the document as a template by
selecting File>Save As> and select
Browse.
6. Change the Save as Type to Word
Template *.dotx and the path will
change to the default path for
templates.
7. Give the template a new name and
click Save.
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USING TEMPLATES
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READABILITY

Readability is the ease with which a
reader can understand written text. The
readability of text depends on its
content (the complexity of its vocabulary
and syntax) and typography (font size,
line height, and line length). Researchers
have used various factors to measure
readability, such as:
 Speed of perception

 Perceptibility in peripheral vision
 Visibility
 Reflex blink technique
 Rate of work (reading speed)
 Eye movements
 Fatigue in reading

 Perceptibility at a distance
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MECHANICS OF TECHNICAL WRITING (CONTD)
READABILITY

Sadly, the average grade level of
readability in the US has been declining.
Current statistics show that it is between the
7th and 8th grade. Your company will likely
have a sense of its audience and the grade
level they want to aim for in written
documentation. It may be higher or lower
than the 8th grade.

Microsoft Word has a tool to
assess the readability of
documents. Once you turn it on, it
will always display the
readability scores after you do a
spell/grammar check.

What is your company’s guideline for
reading grade level? If you don’t have a
company guideline, use the 8th grade as the
level to aim for.
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To Turn on Readability Statistics:
1. From the File menu, select Options.
2. In the section called “When
Correcting Spelling and Grammar in
Word” check the Show readability
statistics box.

3. Click OK to keep your changes.

To Display Readability Statistics:
1. Follow the directions to perform a
Spell and Grammar check in the next
set of slides.
2. After the Spell and Grammar checks
have been completed, the
readability statistics will display.
3. Click OK to close the dialog box.
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To Review and Revise a Readability Score:
1. Review the score called the Flesch-Kincaid
Grade Level.
2. Because the score is too high for the 8th grade
level we want to aim for in our document, we
need to edit the document and then rerun
proofing to determine if our changes reduced
the reading level.
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Changes You Can Make to Impact Readability
Scores:
 Reduce the complexity of sentences.
 Substitute words with more commonly used
versions.
 Restrict the sentence length to fewer than twenty
words.
 Write in a brief and precise style.
 Avoid using words with more than three syllables.
 Avoid jargon and technical words as much as
possible.
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In addition to issues with word length
and sentence structure, there are other
things that impact readability. They are:
 Fonts – size, font family, and style
(bold, italics, or regular). Serif vs. san
serif fonts.
 Paragraph - alignment, spacing
between lines in a paragraph, and
indentation.
 Page Layouts – margins, page or
screen size, columns, and other spatial
parameters.

 Colors of text and background – The
darkest text on the lightest
background provides the best contrast
for readability.
Otherwise, the screen color will
“absorb” the text and make it more
difficult to discern letters. Experiment
with other screen and font colors to
discover why this is.
Remember reading green text on a
black screen?
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Q: Why are spell checking and grammar
checking so important for technical
writers?
A: If readers find errors in your writing,
they lose trust in the rest of your
document. Every inaccuracy undermines
the faith readers will have in your work.
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To Turn On Proofing in Word:
1. From the File menu, select Proofing,
and then select the options you want
to use in proofing your document.
2. Click OK to save your changes.
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To Spell and Grammar Check Your
Document:
1. Open a Word document.
2. Click the Review tab.

4. In the Grammar or Spell Check pane,
address issues as they come up to
correct problems in your document.
5. Click OK when the review is
complete.

3. Click the Spelling & Grammar icon.
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Track Changes is a tool that lets you view
changes that other reviews make to a version
of your document.
Imagine that you have the source document
and there are other versions containing work
done by other reviewers.
You are able to view changes and comments,
determine if they are relevant to your
version of your document, and either allow or
disallow them into your source version of
your document. You can merge documents or
just enter the changes into your document by
viewing the reviewed document on another
screen and typing in the ones you want to
keep in your source document.

Turning On Track Changes:
1.

Click on the Review tab.

2.

Click on the Track Changes icon (Ctrl+Shift+E).

3.

Select Track Changes.

4.

Save your document, and then you can attach it to an
email and request reviewing. This way you won’t
have to request that reviewers remember to turn the
tool on or off.
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Most companies have few resources for
reviewing documentation. The days of having
a sole editing resource are pretty much gone
and so we learn to work as best we can with
fewer resources. Working with few resources
means using your tools well and developing
other strategies to get what you need to turn
out accurate work.
TIP - Perform spell checks, grammar checks,
and even print out and review your document
prior to sending it out for review so your
reviewers can concentrate on the content and
not be distracted by other issues with your
document.

Before Submitting Your Document for
Review:
In Your Document
1.

Proof your document.

2.

Check the readability.

3.

Print it out and do a visual and a reading
check of the document; make corrections.

4.

Spell check again.

5.

Turn on Track Changes and save the
document.
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Before Submitting Your Document for Review:
Write an Email
1.

Make a list of items that you want your reviewers to focus on.

2.

Write an email directing them to review all or specific areas of your
document. You could ask specific SMEs to look at sections they were
responsible for helping you create.

3.

Include a return by date.

4.

Indicate how you want to receive comments – in a separate email, in
comments within the document, or in another way.

5.

Spell check everything!

6.

Attach your document to the email and send it out!
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Once you receive reviewer comments, you
have a decision to make:
Q: Do I want to use the reviewer’s document
as my new source and make future changes
to it?
OR
Q: Do I want to merge or enter changes I
agree with into a version 2 of my own
document?
A: My recommendation: Rename your
document to V2 and then with the review
and your V2 copy open, make the reviewer
changes that you like into your V2 version.

Using the Review Tab:
1. Use the Next button to navigate to a revision.
2. Review the change and make it in your V2
document.
3. Accept the change in the reviewer’s copy and click
Next.
4. Use the Comments Next to navigate through
comments and either Accept or Delete the comments.
5. Once you’ve completed all the changes you should
no longer be able to click Next and find a comment
or other change.
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Another way to use reviewer’s comments is to
keep the ones that contain questions and use
them throughout the document creation
process to track questions that need
resolution.
As you review your document, you will see
the existing comments and can send out
emails with a list of questions that exist for a
specific SME to address. This is a great way
to make sure that you don’t release a
document with remaining questions. It is also
a great way to track your remaining
questions inside the document.

Tips for Working with Documents


Branching to non-existing information - If I have a
need to branch to a section of content that doesn’t
exist in my document, I use this convention: For more
information, see page xxx. Then I search on XXX
before I complete my document.



Unclear content - I use red font for content that I
have written but I am not sure of and then search for
red text to review and revise before I submit. Or I
may also add a comment and direct the text to a
SME for review.
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Page Breaks – Do not add hard page breaks
until you are working on the final version of your
document. Content will change and you will end
up changing page breaks.



Headers and Footers - Wait until your content is pretty
solid before you work on your section breaks, footers,
and headers since those sometimes change as your
document grows and content shifts.



Keep with Next – At the same time you are
adding page breaks, you can review your
documentation and add the property “keep with
next” to cause some content to float to the next
page automatically. For example, if you have an
introduction to a list on one page and the list
itself starting on the next, you want to make the
introduction “keep with next” so it will stay with
the list.



Table of Contents and Index – When you make
changes to your content, first turn off paragraph
marks, and then remember to select all (CTRL=A) and
press F9 to automatically update the page numbers
and any new entries for each.

 Always proof your document!

Also use this feature with graphics containing a
caption.
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RECOMMENDED RESOURCES
How to Communicate Technical
Information, by Jonathan Price and
Henry Korman
Designing & Writing Online
Documentation, by William K. Horton

The Microsoft Manual of Style for
Technical Publications, by Microsoft
Press*

Comes with an online version you can install and use
instead of using the book!

The Chicago Manual of Style , by The
University of Chicago Press
Handbook of Technical Writing, by
Brusaw, Alred, and Oliu
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THE END – LAST DETAILS
 Last Questions?
 Thanks for attending!
 Please turn off your computers before you leave.
 Please turn in your evaluations before you leave.
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